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MacDraw Pro and Color

P-2

Paint-and-brush artists have long used palettes to provide a selection of
dozens of colors. With the MacDraw™ Pro application, each electronic palette
that you use can hold thousands of colors. You can organize colors in
logically grouped color schemes and you can create many palettes for
different purposes. The number of palettes and colors available to you is

limited only by the available memory and the color capabilities of your
Macintosh system software and hardware. With this large color selection, you
can use MacDraw Pro to increase the visual impact, interest, and therefore,
the success of your color graphics. Figure P-1 shows an example of a color
graphic created in MacDraw Pro.



= P-1

Color graphics created in

 

MacDraw Pro

When creating color documents with MacDraw Pro, you can

m create colored drawings with subtle changes in hues, tints, shades, and

tones (figure P-2).

Figure P-2
Drawing with subtle

changes in color
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= import scanned images rendered in color or in many shades of gray, and
edit the colors or grays that appear in the image (figure P-3).

Figure P-3
Scanned image

 

m use special shading patterns, called gradients, that provide graduated
color changes in images and can also be used to produce highlights and
simulate depth in your graphics (figure P-4).

 Figure P-4
Image with gradients all ye

DANE
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= print your color documents in color or in black and white (figure P-5).

 

Figure P-5
Image in color and in

black and white

    

 

 

¢@ Important Before using MacDraw Pro in color, make sure you have

installed and set up the required software and hardware. Refer to the

MacDraw Pro Getting Started manual for information about hardware

and software requirements and installation instructions.

About the Color Guide

This guide provides a general introduction to using color with MacDraw Pro.

It provides explanations of basic color principles and how to use

MacDraw Pro color features.

Before you use this guide, you may want to familiarize yourself with the

MacDraw Pro palettes and the Style bar. For complete information on the

Color, Pattern, and Gradient palettes (including step-by-step procedures), refer

to chapter 5, “Using the Style Palette,” in the MacDraw Pro User’s Guide.
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This Guide is organized as follows:

= Chapter | introduces the fundamental concepts of color theory and the

color systems that you can use to create and edit colors. If you are already
familiar with the HSL, RGB, and CMYK color systems, you may want to
skip chapter 1.

m= Chapter 2 introduces MacDraw Pro color features and shows color
examples. It explains the fundamentals of how MacDraw Pro produces

color on a Macintosh and the functions of the Color Editor.

= Chapter 3 presents the different printing methods you can use to print
your MacDraw Pro documents in color.

¢ Note All the artwork in this guide was created in MacDraw Pro. The final
color graphics were color separated and then output on a Linotronic 300P

imagesetter.

Memory Requirements for Working with Color

The amount of memory required to run MacDraw Pro depends on several

factors, including your type of monitor and video card and the number of
colors they can display. When determining how much memory you can

allocate to the application (when running under MultiFinder), remember that

the system software requires a significant amount of memory, and

MacDraw Pro requires an additional 2 Megabytes (MB) of memory. If you
are checking spelling as you type, MacDraw Pro requires an additional 70K
of memory. Your desk accessories, INITs, and the RAM cache also require
additional memory. The memory required to create a document also varies

depending on the size and complexity of the drawing.

You can set up your Macintosh to display the maximum number of colors
possible, limit it to showing fewer colors, or make it display only black,
white, and grays. If limited memory is available as you use MacDraw Pro,

you can use the Control Panel to set your system to use fewer colors or gray
scales. Refer to your Macintosh Owner’s Guide and monitor and color card
manuals for information about setting up your monitor to display colors.
These are some recommendations:



a /f you are using the Apple color monitor with 256 colors—Allocate at

least 2 MB of RAM to MacDraw Pro for use with MultiFinder.

a Jfyou use a color monitor and your Macintosh has 2 MB of RAM—

Work with MacDraw Pro using the Finder (not using MultiFinder).

a Jfyour Macintosh has 1 MB ofmemory—It’s recommended that you

limit your display to two colors (black and white).

For information about allocating memory to MacDraw Pro, refer to

“Allocating More Memory for Color Documents” in the MacDraw Pro

Getting Started manual.

¢ Tip The amount of memory required for using MacDraw Pro also varies

with the size of the document window. To increase the amount of
available memory, make your document window smaller.

Displaying Documents on a Macintosh with Different Color Settings

When you create a document with your Macintosh set to display a specific

number of colors, you can work on the same document using a Macintosh set

to display a different number of colors. For example, you can open a 256-

color document on a Macintosh set to display 16 colors. You can also change

color settings as you work on a document.

Depending on the settings and hardware configuration, MacDraw Pro

displays as many of the original colors as possible. For colors it cannot

reproduce, MacDraw Pro displays approximated colors. For more

information about approximated colors, refer to “Solid and Approximated

Colors” later in this guide.

If you open or create a color document on a Macintosh that has a black-and-

white monitor, color appears in shades of gray that approximate the gray

value of the color (figure P-6). You can select and use colors and colored

gradients from the palettes. (As you work on a document, you can display

colors and gradients in a palette by name. This makes it easy to distinguish

between different colors or gradients.) Although the document appears in

shades of gray, it will appear in color when opened on a Macintosh that has a

color monitor. (It will also appear in color if it is printed on a color printer.)
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Figure P-6
Color document displayed in

color and shades of gray
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Chapter 1

Choosing a Color System
To work with MacDraw Pro documents in color, it is helpful to understand

the fundamental concepts of color theory and how a computer system

produces color. With MacDraw Pro you can create and edit colors using any

of three color systems: HSL, RGB, and CMYK. (In addition, you can access

other color systems via the Apple Color Wheel.) This chapter briefly
discusses the three color systems and describes how you can use them to

create and edit colors in MacDraw Pro documents.

Color Basics

A color system is a way of systematically organizing and defining colors.

You use a color system to define colors by specific components. Knowing a

color’s components, you can then reproduce the same color whenever you

need it.

For example, a traditional color system for mixing paint is based upon the

colors red, yellow, and blue (figure 1-1). In this color system, red, yellow,
and blue are the primary colors; that is, you can produce all the colors of the

system by mixing only these three basic color paints. To produce a



nonprimary color of a specific hue, you mix the two primary colors located

on both sides of the desired color on the chart. For example, by mixing blue

and yellow paint, you can produce green.

Figure 1-1

Red, yellow, blue color circle

 

Other color systems may define colors using different primary colors or

color components, depending on the medium used to produce color.

The HSL color system, one of the three systems used by MacDraw Pro, is

based on concepts artists have traditionally used for organizing color scales

or palettes. This system defines colors according to three color components

of hue, saturation, and lightness (HSL). Thus, if you are already familiar with

creating or defining color in these traditional artistic terms, you'll find

producing and changing colors using the HSL system easy.

The RGB color system, which is based upon mixing light, uses the primary

colors of red, green, and blue.

The CMYK color system organizes colors based upon printing technology

and inks developed to produce full-color images printed on paper. This

system defines a color in the basic components of the cyan, magenta, yellow,

and black inks used to produce it. Each color ink serves as a primary color

for producing other printed colors. This system is useful for creating

documents with colors that can be specifically reproduced by traditional ink

printing technology.

You choose a color system according to your preferences and the color

requirements of your work. For example, when creating color documents to

be viewed on the computer screen, you can edit color using the RGB system

Choosing a Color System 13



and directly manipulate the monitor’s red, green, and blue color components.
You can use the HSL system to create a special tint, tone, or shade. For
documents that will be printed using a conventional printshop technology,
you can use the CMYK system to produce colors that match standards in the
printing industry.

As you work on a document, you can switch color systems and create the

majority of colors in one system and other colors in another.

¢ Note Switching color systems while editing a document doesn’t change
the appearance of a document’s colors; it only changes the way colors
are defined.

HSL Color System

Figure 1-2
Orange color with varied

saturation levels

The HSL color system is based on the three color components of hue,

saturation, and lightness. Within this system, it is easy to produce colors in
controlled shades, tints, and tones.

A color’s hue distinguishes one color from another by its general look
(wavelength) such as red, blue, green, or yellow.

A color’s saturation represents its intensity or purity (chroma). High
saturation colors approach the look of pure hues; low saturation colors
approach the look of neutral gray. Figure 1-2 shows an orange hue that varies
in four different levels of saturation. By varying a color’s saturation, you
vary the hue from pure to gray.

 

  
100% 75% 50% 25%

A color’s lightness refers to the lightness or darkness of the color (its
brightness). Pink is a hue with high lightness. Maroon is a hue with low
lightness. Changing the lightness of a color may appear to change its hue as

you create color shades (actually the hue stays the same; only its lightness
varies). For example, lowering the lightness of a red produces brown.
Figure 1-3 shows four hues changed through four levels of lightness.



Figure 1-3
Colors changed given four

levels of lightness

Figure 1-4
Ared hue changed by

lightness and saturation

100% 75% 50% 25%

When changing a color with the HSL color system, you select a hue and then

change its saturation and lightness levels. For example, to producea light
pink tint, you select a red hue and increase its lightness. To produce a deep

red, you give the color a high saturation and a medium amount of lightness

(figure 1-4).

100% Saturation : 100% Saturation

50% Lightness 75% Lightness

50% Saturation 50% Saturation

50% Lightness 25% Lightness

RGB Color System

The RGB color system is based on mixing light to produce colors. Because

MacDraw Pro documents appear as dots of light on the computer monitor,

using the RGB color system to edit colors most closely matches the way the

computer actually produces color. This system is useful for creating

documents to be viewed on the computer screen.

To understand the RGB color system, it’s helpful to know about the

properties of light and how a color monitor produces color.

Color appears on the computer screen as light. Although electromagnetic

energy (light) is actually colorless, your eyes perceive and interpret the

different wavelengths of light emitted from the screen as colors. Sunlight

(white light) contains all the spectral colors, and therefore when it is refracted

by a prism, it breaks down into its components — the colors of the rainbow.

When you recombine all the colors of the rainbow, the mix results in white
light again (figure 1-5).

Choosing a Color System 1-5



Figure 1-5
Refraction of sunlight into

colors

Figure 1-6
Red, green, and blue picture

elements of a color monitor

 

Color monitors create colors by mixing three primary color lights: red, green,
and blue. For example, when the monitor displays a combination of red and

blue light, your eyes perceive magenta. Most color monitors are equipped
with three electron guns and have three different phosphors placed on the

screen that emit red, green, and blue light only. Color images are made up of
dots called pixels; each pixel in turn is made up of three dots that display red,

green, and blue. The computer varies the amount of red, green, and blue light
that appears at each pixel, and our eyes combine the primary colors to see

colors of every hue (figure 1-6).

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  
 

  



Figure 1-7
RGB color circle

Figure 1-8
Red and green light combine

to produce yellow

To change a color using the RGB system, you vary the amounts of red,

green, and blue that appear per pixel on the screen (figure 1-7). Your eyes

pick up the different levels of red, green, and blue; your perception mixes

them to see a specific color. For example, a combination of red and green

light produces yellow (figure 1-7).

 

¢ Note If you are familiar with mixing paints based on the red, blue, and

yellow color theory, remember that combining two colors of light
producesa different color than mixing the same two colors of paint. For

example, combining red and green paint produces brown, whereas red

and green light produces yellow.

If you add a small amount of green light to red, the color appears more

orange. If you add more green to the combination (keeping red the same) the

orange becomes lighter and lighter until it appears yellow (figure 1-8).

 

To create light (whiter) colors, you combine high amounts of red, green, and

blue light. For example, to produce pink, you combine a high amount of red

with lesser amounts of green and blue. Figure 1-9 shows the varying levels

of red, green, and blue light used to produce progressively lighter tints of red.
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Figure 1-9
Adding greater percentages

of green and blue to

produce a lighter color red 100% Red 100%Red  100%Red 100% Red

15% Green 40%Green 65% Green 90% Green

15% Blue 40% Blue  65%Blue 90% Blue

To produce white, you combine the maximum amount of red, green, and

blue in equal percentages. For example, combining 100 percent red, 100

percent blue, and 100 percent green produces the brightest white the screen

can produce. To produce a shade of gray, you lower the percentages of red,
green, and blue, while at the same time maintaining an equal ratio of colors.
For example, 50 percent red, 50 percent green, and 50 percent blue creates a

medium gray on the screen.

To produce darker (blacker) colors, you lower the percentages of red, green,

and blue in combination, until the screen emits no red, green, or blue light,
which produces black.

CMYK Color System

Another color system used by MacDraw Pro is CMYK. It organizes colors
based upon printing technology and inks developed to produce full-color
images printed on paper. This system defines a color in the basic components
of the cyan, magenta, yellow, and black inks used to produce it. Each color
ink serves as a primary color for producing other printed colors. The four
inks are combined in a method called process color. The MacDraw Pro
CMYK system is useful for creating documents with colors that can be

specifically reproduced by traditional ink printing technology.

¢ Note For more information about the printing processes used to produce
color on paper, refer to chapter 3, “Printing Color Documents.”

As primary colors, cyan, magenta, and yellow inks are used to produce a

wide spectrum of color. Printers use black ink to enhance the definition and

contrast of the color image. To print the different colors of an image, printers
use a photographic method that separates out the different percentages of
cyan, magenta, yellow, and black needed to produce it. They then print the

four separated images on the same paper sheet, each time using a different
colored ink. When you look at the page, your brain combines the four inked
images to perceive a full-color image.



Figure 1-10
Basic color combinations in

CMYK color system

MacDraw Pro allows you to specify a document’s printed colors using the

color components of the CMYK system. This allows you to precisely

designate the percentage combinations of the CMYK inks that a printer
should use to print the document in color. For example, you can specify a

color as 60 percent magenta, 25 percent cyan, and 15 percent yellow.

¢ Important Because RGB monitors produce color with light and printers

produce a paper image with ink, your monitor may not be able to exactly

reproduce the look of printed colors. CMYK colors in a document will
appear according to their ink color specifications when printed.

To change a color using the CMYK system, you vary the percentages of
cyan, magenta, and yellow that make up the color. You also increase or

decrease the percentage of black to make the color appear darker or lighter.

For example, a magenta and cyan combination produces blue; cyan and

yellow produces green; and magenta and yellow produces red

(figure 1-10).

100% Cyan §=80% Cyan = 5% Cyan 0% Cyan 10% Cyan = 50% Cyan

80% Magenta 10% Magenta 90% Magenta 60% Magenta 85% Magenta 80% Magenta

20% Yellow 60% Yellow 90% Yellow 100% Yellow 0% Yellow 80% Yellow

0% Black 0% Black 0% Black 10% Black 10% Black © 10% Black

In the CMYK system, ink absorbs light, and so the more ink applied to a

particular spot on the paper, the darker the resulting color. This result is

opposite from the RGB color system in which high percentages of red, green,

and blue light combine to produce white. In the CMYK color system high

percentages of cyan, magenta, and yellow combine to produce black.

¢ Important When printing with process inks, the color and quality of the

paper or other material on which your color image is printed will have an

effect on the colors produced (along with numerous other factors).

Choosing a Color System 19



Figure 1-11
Reducing the percentages of

magenta and yellow to

produce a lighter pink color

1-10

To create lighter (whiter) colors, you combine low percentages of magenta,

yellow, and cyan. For example, to produce pink, you combine a medium
percentage of magenta with a lesser amount of yellow. Lowering the

percentages of each color (while maintaining the same ratio of the

components) produces lighter tints (figure 1-11).

O% Cyan §=O%Cyaon =:0% Cyan

40% Magenta 25% Magenta 10% Magenta

40% Yellow 25% Yellow 10% Yellow

0% Black 0% Black 0% Black

To create dark (blacker) colors, you combine high percentages of magenta,

yellow, cyan and perhaps increase the percentage of black. For example,
combining high percentages of magenta and yellow and increasing the

percentage of cyan (or black) in the color produces progressively darker
shades of brown.

To produce muted or grayed colors, you combine low to medium percentages

of cyan, magenta, and yellow with a low percentage of black. Increasing the

percentages, particularly the black, creates darker colors. If enough ink is

present, or if the black percentage is very high, the image area appears black.



Chapter 2

  

  

 

MacDraw Pro Color

Color Patterns

Color Gradients



 

MacDraw Pro Color

 

  
 

 

Colors and Objects

With MacDraw Pro, you can fill individual objects with any color in the Style
or Color palettes (figure 2-1).

Figure 2-1 Ll Bn ey \GVONA
MacDraw Pro Style and Color

palettes

Style palette

Color palette  
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After you fill an object with a color, MacDraw Pro records the object’s color

independently from the colors in the palettes. Even if you change or edit the

colors in the Color or Style palettes, the filled objects in the document retain

their original colors. Editing or eliminating colors from the Color or Style

palette does not directly change the appearance of objects filled with those

colors.

Color Palettes

Figure 2-2
Claris Colors palette

Black

White

Hues scaled in 7 steps

MacDraw Pro comes preset with the Claris Colors palette ready for use

(figure 2-2).

  

   
 

 

 

 

 

 

             
 

 

 

amas Claris Colors :
File Edit Yiew Special -— 19 shades of gray

bl a Tit tom
<al Be    

The Claris Colors palette has 168 colors, including white, black, and 19

shades of gray. The palette’s colors are arranged in hues varied in equal steps.

You can customize the Claris Colors palette by adding new colors, changing

or eliminating existing ones, and rearranging the order of the colors. For an

explanation of the procedures used for editing and rearranging the cells of the

Color palette, refer to chapter 5 in the MacDraw Pro User’s Guide.

MacDraw Pro can have more than one palette of colors open at once; you can

switch palettes to select different colors. You can create palettes of warm

colors, cool colors, tints, shades, tones, and so on — organizing your palettes

to suit your work (figure 2-3).
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Figure 2-3
You can organize a selection

of colors into a palette

2-4
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Although MacDraw Pro displays one color palette in the Color palette

window at a time, you can use colors from other palettes. When you switch
palettes, some-colors in a drawing may temporarily appear as approximated
(dithered) colors. MacDraw Pro produces approximated colors by combining
two colors to produce the look of a third color. (For more information about

approximated colors refer to “Solid and Approximated Colors” in this
chapter.) To avoid approximated colors, copy color cells selected from other
palettes into one main palette for a document, or drag them into the Style bar.

Then, MacDraw Pro will not approximate colors unless more colors appear

in a document than your system can display.

¢ Note You can check how many colors you can use in a document by
choosing About MacDraw Pro from the Apple menu and reading the

Available colors display.

MacDraw Pro also provides additional color palettes that you can install and

use. (Refer to the MacDraw Pro Getting Started manual for information
about installation.) You can open and use these palettes as you work. Some

of the color palettes supplied on the Program 2 disk are:

a PANTONE palettes

a Apple System palette

a 16 Colors palette

a 100 Grays palette

= Special Color palettes

a Presentation Color palettes



Figure 2-4
Pantone palette with colors

displayed by names

PANTONE Palettes

You can use PANTONE colors to designate standard colors to appear in

specific areas in a graphic. To specify colors using the PANTONE
MATCHING SYSTEM, you use the PANTONE color palettes provided with

MacDraw Pro. With these palettes you can precisely designate colors

according to the PANTONE standards used by printers. You can also set the

palette to display the colors accompanied by their standard printing-industry

names (figure 2-4).
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«@ Note If you don’t have a 8-, 24-, or 32-bit color display card, your

Macintosh may approximate some of the many PANTONE colors in the

PANTONE palettes. Approximating on the screen does not affect the

look of the printed color. When printed with a printer licensed to produce

PANTONE color simulations, all PANTONE colors in a document will
print according to their standard specifications.

¢ Tip To work with spot colors in MacDraw Pro, create a layer and place

objects on it that you want to hold a specific PANTONE color. You can

create a layer for each spot color used. Then you can print the individual

layers and give them to your printer with instructions noting the

PANTONE colors to be used.
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Figure 2-5
Apple System Palette

Figure 2-6
Sixteen Colors palette

26

Apple System Palette

The Apple System Palette displays the Apple standard 256 colors (figure 2-5).
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Sixteen Colors Palette

If you set your Macintosh to display 16 colors, use the Sixteen Colors palette
for a balanced selection of 16 different colors (figure 2-6).
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100 Grays Palette

The 100 Grays palette provides a selection of 100 grays (figure 2-7). Use this
palette when creating black-and-white documents.



 

  
 

 

 

 

 

                      

 

   
 

 

  
 

 

 

 

 

 

 

      

 

Figure 2-7 = 100 Grays;
100 Grays palette - - ~ -
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Special Color Palettes

Also provided are palettes with blends of specific colors, such as violet and

magenta (figure 2-8).
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Creating and Editing Colors

You create new colors in the Color palette by adding color cells or by editing
existing colors. You create new color cells by choosing New Color from the

Color palette’s File menu, or by copying and pasting color cells into a palette.

You change selected color cells with the Color Editor dialog box

(figure 2-9).

 

 

 

 

 

Figure 2-9
Color Editor

Color Editor

Color name |—Name: [Vivid purple-red ] %—}-—— Padlock icon

Color bar

Color Systems pop-up menu —

Slide bars
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To display the Color Editor, choose Edit Colors from the Color palette’s Edit
menu, choose Colors from the Layout menu, or double-click the color cell you

want to edit in the Color palette.

You use the Color Editor and the Color palette together. You can select a color
in the Color palette, edit it with the Color Editor, and then select other colors
in the Color palette for editing. As you edit a palette, you can keep the Color
Editor open on the screen until you no longer need it. When your color editing
is complete, click OK to accept your color changes and the editor disappears.

(The Color palette also disappears if it was not previously displayed.)

When you select a color for editing, the Color Editor automatically selects the

color system last used to specify the color’s components. As you work with
the Color Editor, each slide bar represents a color component for the current
color system, such as hue, saturation, or lightness (HSL color system).



Figure 2-10
Adjusting a slide bar

changes the selected color

Selected color shown in the ——
color bar

The slide bars also show the colors you can obtain by adjusting each bar.

You drag the handle of the slide bar to the position of the desired color. As

you drag a slide bar handle, the colors shown in the other slide bars adjust to

show the new available colors. If the color you want doesn’t appear in a

particular slide bar, adjust one of the other slide bars to produce the color

(figure 2-10).
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« Note If no colors appear in the slide bars (they appear gray), your

document may be reaching the maximum number of colors available and

the slide bars cannot showa full range of new color choices. This is also

true if you have selected more than one color in the Color palette.

Although the slide bars appear gray, you may still be able to create

additional solid colors in your document until the maximum number of
solid colors is reached.
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As you edit a color, the color bar always shows you the original selected
color and the result of your color editing. (If you select several colors for
editing, the color bar shows all the colors you selected and the results of your
editing.) You can also specify the exact amount of a color component by
entering a number in the corresponding entry box.

If you prefer, you can use buttons in the Color Editor to change a color
instead of using the slide bars (figure 2-11). You click the small flag at the
bottom right corner of the Color Editor to display the color editing buttons.
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color appear warmer (redder) [ Stead ] [Senter] ([ Invert | f Wheel... |_|+—— Click Wheel to change a

color using the standard|
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Click Blend to create —
a range of selected colors

 

  

Click Similar to change selected Click Invert to change the

colors to make them appear color to its complement

similar in one color component —_(opposite) in the color system

For an explanation of the procedures and other Color Editor options you can
use to edit colors, refer to chapter 5 in the MacDraw Pro User’s Guide.

¢ Note Switching color systems while editing a document doesn’t change
the appearance of a document’s colors; it only changes the way in which
they are defined in the Color Editor dialog box.
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Figure 2-12
Color Editor set to HSL

system

Figure 2-13
Changing a hue by varying

its saturation and lightness

Editing Colors Using HSL

When you edit colors using the HSL color system, the Color Editor displays
slide bars that you can use to change the hue, saturation, and lightness that

make up the color (figure 2-12).
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Cancel 
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Figure 2-13 shows how changing the saturation and lightness of a color by

different amounts affects a specific hue.

Saturation

100% 75% 50% 25%

Lightness 90% 3 a

a
m | | FF
nt

¢ Note The illustrations reproduced in this manual are printed
approximations of HSL and RGB colors that you see on your monitor.
The colors produced by printed inks do not always accurately reflect
colors produced as light on the computer screen.
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Editing Colors Using RGB

When you edit colors using the RGB color system, the Color Editor displays

slide bars that change the percentage of red, green, and blue that make up the

color (figure 2-14).

 

 

 

 

 

 

 

  

 

 

 

    

 

Figure 2-14 SS color Editor
Color Editor set for RGB —
system Name: [Brilliant blue-purple ] 4
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You change a color by adjusting the slide bars to different percentages of
each component. Use this table to help you determine which components to

change when editing colors in RGB. Figure 2-15 shows the percentages of
red, green, and blue required to produce different basic colors.

Figure 2-15 75% Red 40% Red oo 0% Red a 30% Red

40% Green 0% Green 40% Green 65% Green
RGB color table 100% Bue 80% Blue 80% Blue 100% Ble

 

100% Red : 100% Red 0% Red 0% Red

30% Green 35% Green 40% Green 80% Green

75% Blue : 10% Blue 20% Blue 10% Blue

100% Red 60% Red 40% Red 100% Red

0% Green eae 0% Green 20% Green ae 100% Green

0% Blue 0% Blue 0% Blue 10% Blue
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Figure 2-16
Color Editor set for

CMYK system

Figure 2-17
CMYK colors

Editing Colors Using CMYK

When you edit colors using the CMYK color system, the Color Editor
displays slide bars that you can use to change the percentages of magenta,

yellow, cyan, and black that make up the color (figure 2-16).
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To help you determine which components to change when editing color in

CMYK, figure 2-17 shows the percentages of magenta, yellow, and cyan

required to produce different basic colors.

: 100% Cyan 70% Cyan

70% Magneta : 100% Magneta 60% Magneta 35% Magneta

10% Yellow _ 20% Yellow 80% Yellow 0% Yellow =

0% Cyan 40% Cyan 100% Cyan 100% Cyan

70% Magneta 100% Magneta ee 60% Magneta a 20% Magneta ae
0% Yellow 40% Yellow 20% Yellow 40% Yellow

0% Cyan 40% Cyan 60% Cyan 80% Cyan

75% Magneta 100% Magneta 80% Magneta 50% Magneta

100% Yellow 100% Yellow 100% Yellow 90% Yellow

The printing industry uses color charts to specify the various percentages of
cyan, yellow, magenta, and black inks used to produce specific colors. You
can also use these charts to guide you when specifying colors in the

MacDraw Pro Color Editor. The charts are often available from film or
printing vendors.

25% Cyan ie 60% Cyan

  

 

MacDraw Pro Color 2-13



Figure 2-18
Selecting a range of colors

to blend

Starting color cell

Creating a Range of Colors with Blend

MacDraw Pro can automatically create a range of colors that change from
one color to the next in equal amounts. For example, you can have

MacDraw Pro create a range of five different yellows that change from light
yellow to yellow-orange in five equal steps. Blending colors allows you to

create intermediate colors betweena starting color and ending color that you

select. You can create as many intermediate steps in a range as you want.

To create a blend, drag new or existing cells to hold the blend into position in

the Color palette. Arrange the cells in a row or column beginning with the

starting color, followed by intermediate color cells, and ending with the

ending color cell. Next, select the cells to be blended including the starting

and ending color (figure 2-18). (To create a blend, you must select at least

three cells.) When you select cells, the starting and ending colors are the

cells on the ends of the row or at the top and bottom of the column. You can

select cells by Shift-clicking or dragging a selection box around the cells.
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  Ending color cell
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After selecting the cells, display the Color Editor (if it is not already
displayed) and click the Blend button. MacDraw Pro fills the intermediate
cells with colors that change in equal steps from the starting color to the

ending color (figure 2-19). The more cells you place between the starting and

ending colors, the more intermediate colors MacDraw Pro produces.



Figure 2-19
Resulting blend of colors

Starting color cell —

Intermediate color cells

    
 

 

 

 

 

Ending color cell

Figure 2-20
Blending a block of color

cells
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You can also select several rows or columns of color cells and blend them.

MacDraw Pro creates a blend using the cell in the top left corner of the

selected block of cells as the starting color and last cell in the lower right
corner of the block as an ending color. All cells between the starting and

ending color are filled with the blend (figure 2-20).

 

 Starting color cell
 

  
 

    

Ending color cell Resulting blend

To create a range of colors:

1. Select the starting color, ending color, and intermediate cells that you want to fill with a

range of colors.

2. Choose Colors from the Layout menu.

The Color Editor dialog box appears.

3. Click the flag icon to display the color buttons for editing (figure 2-21).
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4. Click Blend.

MacDraw Pro fills the selected intermediate cells with the range of
colors.

5. Click OK.

= Toclose the Color Editor without making any changes to the selected

colors, click Cancel.

= To restore the colors to the way they were when selected, click
Revert.

¢ Tip MacDraw Pro blends the colors using the color system you have

chosen. Different color systems will produce different blends of colors.
For blends of the finest visual gradations, use the CMYK color system.

To display gradients on screen with finely graduated color changes,

blend colors and select the blended colors as the gradient’s starting and

ending colors.

Creating four-corner blends You can create blends that change between four colors
(instead of betweena starting and ending color only). To create a blend
based upon four colors (called a four-corner blend), you arrange four base

colors in the corners of a block of cells (figure 2-22).
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Figure 2-22
Block of cells selected for

blending

Figure 2-23
Block of cells blended to

produce intermediate colors
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You then select the block and Option-click the Blend button in the Color
Editor. MacDraw Pro calculates intermediate color steps between the four
base colors and reproduces them in the cells in the block (figure 2-23).
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To create a four-corner blend of colors:

1. With a color palette open, arrange four base colors in the corners of a block of cells and

select the block.

2. Choose Colors from the Layout menu.

The Color Editor dialog box appears.

3. Click the flag icon to display the color buttons for editing.

4. Option-click Blend.

MacDraw Pro fills the selected block of cells with intermediate colors.
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Figure 2-24
Similar By dialog box

Components for the HSL

color system

2-18

5. Click OK.

To close the Color Editor without making any changes to the selected
colors, click Cancel.

To restore the colors to the way they were when selected, click Revert.

Making Colors Similar

With MacDraw Pro you can select a range of different colors and change
them so that they appear similar. Colors appear similar because they are
given the same amount of one color component of the color system. For
example, using the HSL color system, you might changea selection of colors
so that they all have the same saturation. The different colors will appear
similar because they are alike in one component of the color system.

To make colors similar, select the colors that you want to change and display
the Color Editor. Click the Similar button to display the Similar By dialog
box. Choose the component you want to change for the selected colors. The
dialog box shows the components for the current color system. Figure 2-24
shows the components for the HSL color system.
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Click the button for the color component that you want the colors to share
and then click OK. For example, to give the selected colors all the same
saturation, you click the Saturation button. MacDraw Pro then calculates the
average of that color component for all the selected colors and assigns that
average value to each color.



To create a range of similar colors:

1. Select the color cells that you want to make similar.

2. Choose Colors from the Layout menu.

The Color Editor dialog box appears.

3. Click the flag icon to display the color buttons for editing (figure 2-25).

 

 

 

 

 

  

 

 

 

 

 

  
   

Figure 2-25 Color Editor
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4. Click Similar.

The Similar By dialog box appears (Figure 2-26).

Figure 2-26
Similar By dialog box
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A button for each component of the current color system appears in the

dialog box.

5. Click the button for the color component that you want all the colors to share.

6. Click OK.

MacDraw Pro finds the average value of that component for the selected

colors. It then assigns the average value for that component to all the

selected colors.

7. Click OK or select another color for editing.

= Toclose the Color Editor without making any changes to the selected

colors, click Cancel.

= To restore the colors to the way they were when selected, click
Revert.

Changing Color in Imported Images

You can import color images that have been scanned or created in other
applications (figure 2-27). Once the color image is imported as an object in
the document, you can edit the colors in the image. For example, a scanned

image might show red. If the particular red does not go well with the colors
in a document, you can change the red to a voilet or a different color.

Figure 2-27
Imported image
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To change the colors in an imported image, select the image as an object and

choose Image Colors from the Color palette’s Special menu. MacDraw Pro

analyzes the colors used in the image and creates a special Color palette whose

colors are linked to the imported image. Each cell in the palette holds a color

found in the image. You cannot add colors or delete them from this palette.

¢ Note A 24- or 32-bit color image can potentially have many thousands of
colors. When you use Image Color to edit such an image, MacDraw Pro

will create a palette of over 200 of the most used colors in the image. Slight

color variations of a particular color may be represented as one color.

You can select and edit the cells in the palette with the Color Editor. As you

changea color with the Color Editor, the color also changes in the color

image (figure 2-28).

Figure 2-28
Editing a color cell in the

palette changes that color in

the image        
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When you edit a color, the edited color changes everywhere it appears in the
image. For example, if a color appears in two places in an image, editing the
color changes it in both places. Thus, by editing the different colors in the

special palette, you change the colors in the imported image.

This special color palette becomes the current palette. Its name appears in
italic letters in the palette’s View menu. You can select other objects and fill
them with colors from this palette. You can save the palette, copy colors
from it, and then paste them into other palettes in the document.

To edit an imported color image:

1. Select the imported image.

2. Tear off the Color palette and choose Image Colors from the Special menu.

MacDraw Pro opens a new color palette that contains the colors found in
the image.

3. Select a cell in the Color palette for editing, and choose Colors from the Layout menu; or

double-click the cell you want to edit.

The Color Editor dialog box appears (figure 2-29).
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4. Edit the color.

For information about using the Color Editor to edit colors, refer to
“Editing Colors” in this chapter.

5. Click OK or select another cell in the Color palette for editing.

The color changes you made appear in the imported color image.
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Figure 2-30
Sample solid and

approximated color

 

Solid and Approximated Colors

Each palette can hold thousands of colors, limited only by the available

memory of your Macintosh. If you use a color monitor with a 32-bit color

card, 32-bit QuickDraw installed (refer to MacDraw Pro Getting Started for
installation instructions) and your monitor is set to display millions of colors,

all the colors in the palette will appear as solid colors. Other Macintosh

configurations will show fewer solid colors (up to 256 solid colors for
Macintosh computers with an 8-bit Apple color card). Other colors will
appear as approximated colors.

The Macintosh produces approximated colors by mixing colors already on

the palette in alternating dots on the screen. The mixing of two colors of
dots, called dithering, creates nearly the same look as a solid color.

However, you may notice a difference between a color produced as solid and

the same one produced as an approximated color (figure 2-30). (Depending

on which solid colors are available, the difference may be very significant).

 

The appearance of solid or approximated colors only pertains to the

screen display of color. The display of approximated colors has no effect

on printing.

Approximated colors occur when you use more colors in a document than

the Macintosh can display on the screen. On a Macintosh that displays 256

solid colors, you will only see approximated colors in the case where a

document has more than 256 different colors in the document, Style bar, the

current color palette, and a reserved system palette combined.

If the number of solid colors in a document is near the maximum number

that the Macintosh can display, changing the current color palette to a palette

with different solid colors may produce approximated colors in the

document. You can restore the approximated colors to solid by making the

previous color palette the current Color palette again.
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MacDraw Pro approximates the color assigned to an object by alternating
two solid colors from the current Color palette, Style bar, or the reserved
system palette. How closely the approximated color matches the desired
solid color depends on the solid colors available in these palettes.
MacDraw Pro selects the best color combination to approximate the color
as closely as possible.

If you use palettes in which approximated colors appear, you may want to
choose which colors appear as solid and which appear as approximated
colors. You can select colors in the Color palette and convert them to solid
by choosing the Solid command from the Special menu. Setting a color to
solid instructs MacDraw Pro to give that color a higher priority to be a solid
color than the other colors in the palette. Converting one color cell to solid
can change an existing solid color cell to an approximated color.

To change a color to solid:

1.

2.

Tear off the Color palette.

Select the color you want fo convert.

Choose Solid from the Color palette’s Special Menu.

Tip If you want certain colors to always appear solid, place them in the
Style bar where MacDraw Pro can find them no matter which palette is

current, or copy them into the Color palette you use most often. Also,
you may want to eliminate unused solid colors from the current Color
palette to allow you to create additional solid colors.



Color Patterns

Figure 2-31
Pattern palette

Figure 2-32
Objects drawn with color

patterns

The Pattern palette provides a choice of black-and-white patterns

(figure 2-31).
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MacDraw Pro also lets you combine a color with a black-and-white pattern

to produce interesting effects (figure 2-32).

A)
ve~ Black-and-white pattern

~ combined with a colorWS t~)

 

Pen pattern

To create a pattern combination, fill an object with a black-and-white pattern

from the Pattern palette. With the object still selected, select a color from the

Color palette. MacDraw Pro will apply the color to the black portions of the

black-and-white fill pattern. To eliminate the pattern combination, select the

object and click the black color cell in the Style bar or Color palette to create

a black-and-white pattern again, or click the solid pattern cell to create a

solid color.

For more information about working with the Pattern palette and Pattern

Editor, refer to chapter 5 in the MacDraw Pro User’s Guide.
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Color Gradients

Figure 2-33
Gradient palette

Figure 2-34
Objects drawn with color

gradients

2-26

The Gradient palette can hold black-and-white and color gradients. The
preset Gradient palette contains black-and-white gradients only. You can

change the preset gradients, adding color to them, or create new gradients
with colors of your choosing (figure 2-33).
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You can use the gradients as fill patterns as you draw and change objects.
You cannot use them as pen patterns. You can create three kinds of
gradients: Directional, Shape Burst, and Circular. Each type fills objects
differently (figure 2-34).

  
Circular gradient Shape Burst gradient —_ Directional gradient

To create or edit a color gradient, choose Gradients from the Layout menu,
or double-click a cell in the Gradient palette. The Color palette, Gradient
palette, and Gradient Editor appear (figure 2-35).



Figure 2-35
Color palette, Gradient

palette, and Gradient Editor

 Color palette

Gradient palette

Gradient Editor ——————

Sample of edited gradient
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With the Gradient Editor on the screen, select the type of gradient you want,

and then select colors for it from the Color palette. When a gradient is to your
liking, you can select another gradient in the Gradient palette for editing
without closing the Gradient Editor. Once you have finished editing gradients

and want to close the Gradient Editor, click OK to accept your changes.

For more information about working with the Gradient palette and Gradient

Editor, refer to chapter 5 in the MacDraw Pro User’s Guide.
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Printing Color Documents
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After creating a color document in MacDraw Pro, you will probably want to
print it in color. This chapter explains some of the ways that you can produce
MacDraw Pro documents in color.

If your computer printer prints in black-and-white only, or if it prints with a

limited number of colors, you have several options for producing high-
quality color documents. MacDraw Pro can print color documents on many
different types of printing devices, including direct color printers, film
recorders for creating slides, and professional imagesetting devices. To use a

specific kind of printer, you install the printer’s printing resources into your
System Folder. Then you can use the Print and Page Setup commands to
print documents using the color printer’s printing options. For information
about installing printing resources and printing documents, refer to the
manual that came with the printer.



Figure 3-1
Galo image printed with

direct color printer

(simulated)

 

@ Note When printing a color document with a black-and-white PostScript

printer, such as the LaserWriter, you can print your document in shades

of gray by selecting the Color/Grayscales option in the Print dialog box.

A Macintosh that displays black-and-white only, such as the Macintosh

SE or Plus, doesn’t support full-color printing on color printers; however,

you can print using a limited number of colors (QuickDraw colors). For

best color printing results, print color documents from a Macintosh

capable of displaying full color.

Direct Color Printing Devices

Some computer printers are capable of creating color images printed directly
on paper (figure 3-1). These printers are useful for printing color overhead

transparencies, proofs, or a final version. The technology used to print color
varies among printers. For example, some direct color printers use simple

colored typewriter-style ribbons, some spray different color inks on the page

(ink jet printers), some use thermal technology, others use laser technology

to fuse different colored toner on paper, and still others use a process of
mixing dyes. Using a direct color printer can be a good way to produce

limited quantities of a color document, but it may be an expensive choice for
producing more than a few copies.

Soe de ee ee
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Figure 3-2
Color slide produced from a

MacDraw Pro document

(simulated)
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Printing Slides with a Film Recorder

For interesting and effective presentations, you can display MacDraw Pro

color graphics as slides. You have two display options when you work with

MacDraw Pro documents as slides. You can display your slides on the

Macintosh screen, or you can use a film recorder to create actual slides for a

slide projector.

After creating slides, you can runa slide presentation directly on the

Macintosh; or you can use a large-screen projection device that displays an

enlarged image of the Macintosh screen. Then, you can use keyboard

commands to display the MacDraw Pro slides one by one on the Macintosh.

The MacDraw Pro Quick Reference Guide, MacDraw Pro Help System, and

chapter 7, in the MacDraw Pro User’s Guide providea list of command

keys you can use to give presentations.

You can also print MacDraw Pro color documents as 35mm slides that you

can display with a standard slide projector (figure 3-2). To produce standard

slides, you attach a computer film recorder to the Macintosh to expose the

images of the MacDraw Pro slides on slide film. This film can then be

developed and mounted as slides. Most film recorders can reproduce the

brilliant screen colors of MacDraw Pro documents with great accuracy. If
you don’t have access to a film recorder device, many service bureaus can

also create 35mm slides from your MacDraw Pro documents.
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Figure 3-3
Color document produced

with an imagesetter

Printing a Color Image on an Imagesetter

To produce many copies of a full-color document with high-quality color,

you may consider using a professional printer.

You or your printer can print color-separated MacDraw Pro documents using

a PostScript imagesetter (3-3).

FRUIT TANGOS

 

Because imagesetters print images with very high resolution, your

MacDraw Pro document can be reproduced with highly defined detail that a

commercial printer can then print in vivid color. Although commercial

printing is an added cost, the printer can produce thousands of copies of your

MacDraw Pro documents.

To producea full-color printed document, you or your printer must create

color separations of the MacDraw Pro document. You can create the color

separations by exporting your document to a page layout application that can

create color separations. (Refer to page 3-7 for step-by-step procedures.)
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Professional Color Printing Processes

Figure 3-4
Color images are printed by

creating color separations

that represent cyan,

magenta, yellow, and black

inks
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To produce color images, commercial printers use a process of overprinting
an image several times with different color inks. Each time color ink is

printed over an image, the ink must print in the right location and in the right
amount so that a combination of different inks produces the desired colors.

To produce a four-color image, printers print an image four times with ink
that is cyan, magenta, yellow, and black. To print just the right amount of ink
in the right places, printers use color separations.

A color separation shows the areas in a graphic where one color ink should

print (figure 3-4). For example, one separation indicates where the cyan ink
should appear, another where the magenta ink should appear, and so on.

When the four different versions are printed on the same page, using the four
different inks, a full-color image is produced.
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Creating Color Separations

To create color separations, you transfer a document to another application
that creates color separations, or give an electronic copy of your document to

a printer to create color separations. You must save the document in the EPSF

(Encapsulated PostScript) format. You can then open the EPSF file with the

other application or give it to a printer with a PostScript imagesetting device

to print the EPSF file as color separations.

To create an EPSF file of your document:

1. Choose Save As from the File menu.

2. Choose EPSF from the Show pop-up menu.

Give a new name to the document, if you like, by typing one in the

name box.

3. Click Save.

Important Different equipment or processes (xerography, photography,

web or sheetfed lithography, intaglio, gravure, or flexography), different
materials (film, paper, board, or plastic), and different design properties

(spot color, line screen count, or undercolor removal) can affect the way

color separations need to be made, and the way the color image can appear

to the viewer. You should know these requirements in advance, or consult
with your service bureau, film vendor, printer, or a professional advisor.
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